


Going Mobile with
Joomla!

The book covers many examples about existing possibilities for websites  made with Joomla! to 
embrace the mobile world. It will consist of  the following topics:

• App economy

• Mobile Templates

• Responsive Templates

• Building a responsive Joomla! Template with the Twitter Bootstrap framework from Scratch

• Joomla! as datasource for native Apps

• Various extensions that help to mobilize your Joomla! 2.5 Website

My aim is  to pave the way for Joomla! sitebuilders  and designers to get in closer contact with the 
mobile world.
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Chapter 1

Introduction
In February 2010 Google adopted a new strategy that the company's focus is  now more on 

smartphones than on desktops. Chief executive Eric Schmidt summed this  up with a new motto: 
"Mobile First". Google developers started to create versions of new services for smartphones  before 
creating ones  to run on PCs. At that time,  the global smartphone penetration reached a average of 15% 
(2009). Two years later,  we talk about a global smartphone penetration of 30% (2011). Only in 2011, 
nearly 500 millions smartphones were shipped (Figure 1).

Figure 1: Smartphone Shipments 20111

At the Mobile World Congress in Barcelona 2012, Google announced:

“There will be an Android in every pocket”

Android is a Linux-based operating system for mobile devices  such as  smartphones and tablet 
computers.

WHAT IS A SMARTPHONE?
I found no official definition of a smartphone in comparison to other phones (feature phones) but I 

see three differences

1. smartphones are always "on-line"
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2. smartphones have a browser to surf  the web

3. smartphones allow applications to have a deep integration with the phone's OS and hardware

The mobile market for feature phones was/is  focused on selling ringtones, games and other content 
brought by the industry to the customer (B2C). The mobile market (app stores)  for smartphones  provides 
the logistic for developers, authors and artists to offer their apps (Digital Distribution Platform).

WHAT DOES IT MEAN FOR MY WEBSITE?
It you already have a website it is time to think about visitors that use other devices then personal 

computers  to access your website. If you are using Google Analytics  it is easily possible to check these 
figures. In Figure 2 you can see that 2.6 % of  the visitors of  this website are using a mobile device.

Figure 2: Google analytics - Mobile Devices

Have a look in your statistics. I asked a question on Facebook2 and got the following answers  (Figure 
3). The percentage of  visitors using mobile devices seems to be around 10 % on "normal" websites.  
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Figure 3: How many visitors of  your website are using mobile devices?

THINK ABOUT YOURSELF
If  you have a mobile device,

• How do you use it?

• Where do you use it?

• at home?

• everywhere?

• in waiting situations?

• Have you ever tried to

• access your website on different mobile devices?

• navigate to the third level (if  there is one)

• log in and out?

• create, edit, delete content?

• upload a file?

• download a file?

• watching the fancy slideshow on your site?

• create a bookmark in the mobile browser?

If you answer most of the last questions with "yes, I already have" that's  good. If not, have a look at 
your mobile device, play around and come back :)

When you start to use your mobile device for surfing the web you will probably find a lot of websites 
that don't care about visitors from mobile devices.
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WHO SHOULD READ THIS BOOK?
You should read it when you are

• already running, creating, using, or planning a Joomla! website

• the owner of  a kind of  mobile device

• thinking about possibilities to "mobilize" your existing or planned Joomla! website.

HOW IS MY/OUR SITUATION?
I'm part of the books target group too. In our household (two persons)  we have an Apple iPhone,  an 

HTC Android phone, an Apple iPad,  two laptops  and a desktop computer (and of course a 
bookshelf :)  ). The usage of the mobile devices increases. The laptops are usually used for "real" work, 
the desktop acts as a media and file server. 

In our daily work we create sites and apps for clients but as  always  ... our own website cocoate.com is 
still not optimized for mobile devices. First, I have to finish this book! :)

WHAT'S COVERED IN THE BOOK?
I am writing the book with the mentioned target group above and me/us with the same "problems" 

in mind. I want to show various aspects of mobile devices and how you can enhance Joomla! to offer 
your content on mobile devices too.
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Advertisement

Your Joomla! site mobilized. Instantly.

Mobile Joomla! is the best way to mobilize your Joomla! site, 
displaying beautifully on iPhone, iPad, Android, Windows Phone and 
all other phones.

http://mobilejoomla.com/
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Chapter 2

Mobile Content Management 

Systems
An important principle of all content management systems (CMS)  is the separation of content from 

presentation. The content is stored in a file system and/or a database. The presentation varies on the 
target medium and can be any markup language like HTML, XML, any file format like DOC, ODT or 
PDF.

Joomla is a Web Content Management System (WCMS). It consists  of the Joomla! platform with the 
Joomla CMS build on top. It offers  the possibility to manage, create,  edit, publish and delete content via 
a web browser. The content is stored in files and in a database.

In the past and of course still today, many people are browsing the web using a personal computer 
(PC). The screen of a PC can have different screen sizes  and screen resolutions  and it is  connected to a 
mouse and a keyboard as "human interface devices" to navigate on websites.

What is changing is the product behind the word PC. A mobile device like a tablet or a smartphone 
is a much more personal device compared to the "traditional" idea of a personal computer with mouse 
and keyboard. Laptops with a touchpad and a keyboard are bridging the gap. Traditional PC's  will more 
or less disappear!

A mobile device does not need a separate keyboard and a mouse anymore. You can navigate by 
touching the screen, point to objects and drag them around.

Such a device

• can see (with one or more cameras)

• can hear (with its microphone)

• knows where it is (with it's GPS sensor)

• knows most of  your contacts

• knows most of  your passwords

• and even listens and talks with you (Siri at the iPhone).
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To be able to enter text, mobile devices offer a displayed touchable keyboard and this works well!

WHAT DOES THIS MEAN FOR THE "GOOD OLD" JOOMLA?
So far Joomla! cannot listen and see,  don't know where the visitor is located and of course,  it cannot 

talk to you!

Is that true?

Well ... if  you look at the existing Joomla 2.5 core - Yes!

If you search the Joomla extension directory3 you'll find many extensions  that could profit from the 
standard features  of a mobile device! These three extensions are just substitutes for location based 
services, video and image recording

Sun Time4 is  calculating the sunrise/sunset time for any place on the planet but you have to enter 
your location.

vpchromeabc5 collects video content in a nice way but cannot record

TwoJToolBox6 is a nice image viewer but cannot take pictures

The lack of  features is not only the problem of  Joomla, it is a general lack of  "good old" websites.

Since 2011, the Joomla platform exists and it is  possible to build web applications based on this 
platform. The Joomla CMS was the first application based on the platform but others are possible,  e.g. 
Square One CMS7 and Molajo8.

With the standardization of  HTML5 in 2014 this situation will change rapidly.

HTML5 includes detailed processing models to encourage more interoperable 
implementations, it extends, improves and rationalises the markup available for 
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documents, and introduces markup and application programming interfaces 
(APIs) for complex web applications. (Wikipedia9)

HTML5 contains features like

• the canvas element for immediate mode 2D drawing.

• offline web applications

• an API for writing to files from web applications

• drag-and-drop

• web storage

• geolocation

• the handling of  file uploads and file manipulation

MOBILE CONTENT MANAGEMENT SYSTEMS
Mobile content management systems (MCMS) should support additional features such as:

Multi channel content delivery (machine-readable web)
It should be possible to publish XML and an application which takes  this XML and delivers it to 

mobile devices.

It should be also possible that the mobile application queries the MCMS directly. The MCMS 
responds with XML that is  rendered and displayed by the mobile device. The evolution of this  feature 
went from service-oriented architecture (SOAP10,  XML-RPC) to resource-oriented architecture 
(Representational State Transfer - REST11).

Specialized templating system (human-readable web)
The templating system is used too to deliver the content to a mobile device. Mobile CMS templates 

must be adapted to a very wide range of  target devices with different capacities and limitations.

There are two approaches to adapt templates:

• multi-client: possible to see all versions of a site at the same domain (example.com), and templates 
are presented based on the device client used for viewing.

• multi-site: displays the mobile site on a targeted sub-domain (mobile.example.com, m.example.com).
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Location based content delivery
This  feature is  important because it did not exist before inside a CMS. Depending on where you are, 

a MCMS can be used for e.g.

• recommending events in a city

• requesting the nearest business or service, such as a restaurant

• receiving alerts, such as notifications of  a sale on gas or warning of  a traffic jam

• location-based mobile advertising
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Advertisement

We believe
The quality at the first place

JoomlaShine products are carefully tested on major web platforms.

Continuously improved code

We don’t write the old code again and again. Instead, we are focusing on continuous 
learning and improvement.

Designed for users

We put the full control of product in one place. You don’t need to have special 
programmers’ skills to have our product working properly.

Customer Service matters

Whether you have general or technical questions, our support team is there for you. 
Just drop us a line.

The product should be affordable

You don’t have to spend thousands of bucks building professional website anymore. 
Our product is affordable with clear license policy. 

http://www.joomlashine.com/
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Chapter 3

Showcase
To get an idea of how mobile websites are looking that are based on Joomla,  I will show you four 

examples. For the screenshot of  the mobile versions I used a two year old HTC WildFire smartphone12.
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DIGITFREAK
DigitFreak is  a social corner where people can talk digital. They can really get an impression what 

new technologies can bring to their life. It is a place where users can discuss and speak codes.

http://www.digitfreak.com/

Mobile Version

 Desktop Version 

Going Mobile with Joomla!

Thursday, 9 August 2012 Page 19



MUGELLO CIRCUIT
Mugello Circuit (Autodromo Internazionale del Mugello)  is  a race track in the Mugello region of 

Italy near Florence.

http://www.mugellocircuit.it/

Mobile Version

Desktop Version
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MONCTON DENTIST
This website is about a dental clinic in Moncton, Canada

http://www.drhenrileblanc.ca/

Mobile Version

Desktop Version
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BIKESTORE
This is a responsive ecommerce Joomla! template from Gavick.

http://demo.gavick.com/joomla16/jun2012/

Mobile Version

Desktop Version
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Advertisement

Joomla! Showroom builds software products and extensions for the 
Joomla! Content Management System. We specialize in custom 
software development and support of the Joomla CMS. We have a 
team of talented and very experienced Joomla developers, 
programers, and designers that can handle any task from the most 
basic to more complexed software and website development.

http://joomlashowroom.com/
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Chapter 4

Common Approaches to Mobilize 

Joomla!
If you already have a Joomla website you are probably interested to make sure that the site works on 

a mobile device. Mobile devices  have unpredictable screen sizes  and the speed of the internet connection 
can be low. The loading of images can take longer. The Abobe Flash player does not exist on all devices 
manufactured by Apple,  and on other platforms it can cause problems  in the sense of speed and stability. 
Advertisements  are hard to display on mobile devices  and last but not least,  the layout of the websites 
desktop versions can be too complex for mobile devices.

SEPARATE MOBILE WEBSITE
In this case, the mobile version is a totally independent website with another URL, mostly the 

subdomain "m.". With extensions like Mobile Joomla it is possible to use your existing content to create a 
separate mobile version.

RESPONSIVE WEBDESIGN
Responsive Web Design tries to adapt the layout to the viewing environment, and probably also use 

flexible images. Have a look at the chapter Responsive Webdesign.

APP
The mobile version is a downloadable app with access to your Joomla website. With extensions  like 

Chimoora you can use your existing Joomla website.
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Advertisement

CRMery is  a native Joomla! CRM that lets you organize your sales and grow your business. 
Customer Relations Management made easy with the only Joomla CRM. The best CRM for Joomla! is 
CRMery.

CRMery is the one and only native CRM solution for Joomla! Experience the power of a full 
featured Customer Relations  Management solution without ever leaving your website. No more per-seat 
per-month charges. Pay once and no more. Store your own data safely and securely on your own server 
and under your complete control, works natively in your Joomla! site.

Mobile
That's right, these days it's  critical to be able to access your information from anywhere. CRMery has  a 
full mobile layout designed specifically for your smartphone and geared to quickly get you the 
information you need most. Get information on a lead or contact including quick access  to auto dial 
phone numbers,  emails,  or click an address  to instantly receive a Google map and even turn-by-turn 
directions!

Manage all your leads, contacts,  companies and deals  with ease. We've put extensive work into 
creating a system that makes  less  work for you. Follow intuitive layouts to quickly keep up to date and 
make your CRM worries fly away

http://www.crmery.com 
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Chapter 5

A Mobile Site with Mobile Joomla
If you have an existing Joomla! website and want to bring this  site to mobile devices, then the Mobile 

Joomla! extension13 is a great way to do it. It offers  you the advantage to have correctly resized images for 
any device and it removes HTML tags that may lead to problems in mobile devices. Apart from these 
important features, there are many more features that allows  an easy and effectiv configuration of your 
desired mobile website:

• User Agent detection (WURFL14, TeraWURFL device database)

• Multi site support (Sub-domain redirection)

• Image adaptation

• Templates per device category

• Menu exclusion per device category

• Customizable with different modules and templates

• Compatibility with 3rd party extensions, modules and components

It is  always  a problem for a company to offer good quality for free. To be able to offer Mobile Joomla 
for free it displays  non-disruptive support ads at the bottom of mobile pages. These ads  help the 
company to provide Mobile Joomla! for free. They would appreciate if you keep these ads to support the 
Mobile Joomla! development, however, if for some reasons you want to remove the ads,  this extension15 
helps you. It's up to you :)

REQUIREMENTS
The following system components are needed for running all Mobile Joomla! features. If your 

hosting provider does not support them, Mobile Joomla! might not fully function or the installation fails.
You can find your data in Site -> System Information -> PHP-Information (Figure 1)

• At least 32 MB of  memory for running PHP scripts (PHP memory limit)
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• PHP gd2 extension (image library for image scaling)

• PHP bz2 extension (to import local dump of  TeraWURFL device database)

• PHP MySQLi extension (prerequirement for TeraWURFL device database)

possibility to load data over HTTP protocol (allow_url_fopen enabled, etc.).   It’s required for Mobile 
Joomla! updates and for downloading TeraWURFL device database in the case of disabled bz2 
extension

Figure 1: Joomla! - PHP Information

For the next three requirements you have to examine the conditions in the admin interface of your 
webspace provider or ask your provider directly. In most cases, modern hosting providers should fulfil 
these requests:

• File creation rights on PHP

• Procedure creation right in MySQL database (prerequisite for Tera- WURFL device database)

• At least 30 MB of  database disk space

INSTALLATION
Register at the Mobile Joomla website and download the component. Install it in Extensions-> 

Extension Manager -> Install (Figure 2). The package consists of a component, various  plugins  and a 
module.
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Figure 2: Mobile Joomla! successfully installed

After the Installation you can choose whether you want to access the documentation16 or go directly 
to the configuration interface of the component. My advise is  just to have a look at your brand new shiny 
website with a mobile device! It was directly created after the installation.

You can see that the main menu from the original website was converted into a different layout (Figure 
3).

Figure 3: PC vs. Mobile Device
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Open the documentation link in a separate window and follow the link to the Mobile Joomla! 
Settings to have a look at the configuration settings.

USER AGENT DETECTION (WURFL, TERAWURFL DEVICE 
DATABASE)

Mobile Joomla comes with two plugins  that are responsible for detecting the correct device. The 
Simple Plugin for detecting common browsers  and the TeraWURFL plugin. Wireless  Universal 
Resource FiLe (WURFL17)  is  a community effort, focused on mobile device detection. Tera-WURFL18 is 
a popular, free and open source PHP WURFL API, managed by the company ScientiaMobile19.

During the installation process,  several tables were created in the database. They store data of nearly 
every mobile device worldwide (Figure 4). The updates  for these tables are coming regularly with the 
Mobile Joomla component update.

Figure 4: WURFL tables
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The device detection simply works. You do not have to configure anything. Both plugins  are activated 
after installation.

MULTI SITE SUPPORT
Depending on your needs it is sometimes necessary to have not only a different template but to have 

a complete different web site for a category of  mobile devices.

Example:

My website has the URL http://joomla25.cocoate.com. I decided to create a special site for older 
WAP devices (or iPhones, or all smartphones).
I added the URL (e.g. wap.joomla25.cocoate.com)  in the Advanced Settings  area and the WAP device 
will be redirected to this URL (Figure 5).

Figure 5: Multi Site

Attention:

The Mobile Joomla component redirects the device but it doesn't create the separate website, that's 
your job! You have to make sure that a website exists!

IMAGE ADAPTATION
Mobile Joomla! supports several modes for processing (adaptation) of  site images:

• Don’t rescale: Keep all the images “as they are”

• Remove all: Remove all the images
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• Rescale if bigger: Resize large images to fit in the device screen (minus value of “Decrease Image 
Width” parameter)

• Fixed rescale ratio: Resize every image based on the ratio between image width and default width 
from “PC template width” parameter

The quality of resulting images  are determined by rescaled image quality (0-100)  parameter of 
Mobile Joomla! Settings. Each rescaled image is placed in Re-sized subdirectory of the directory with 
original image (/images). Note that <img> tags are processed only, and as a result, all the background 
images in CSS styles are unchanged. Mobile Joomla! strips style attribute of images  to fix images having 
wide padding that looks well on desktop, but ugly on mobiles. External images are not rescaled.

Example:

I added this photo20 to an article. The width is  500px and the size 104kb on the normal website. 
Mobile Joomla resizes the image to 280px width and 13kb (Figure 5)

Figure 5: Image Resizing

DEVICE CATEGORIES
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Mobile Joomla differs  devices of four categories. Each device has  its own template. The most 
important categories are Smartphones and iPhone.

• Smartphone
A smartphone is every mobile device excluding iOS based devices.
Template: mobile_pda

• iPhone
The iPhone category covers iOS devices (iPhone,  iPod, iPad). It is based on jQTouch21,  an open source 
JQuery plugin and works as well for Android based phones.
Template: mobile_iphone

• WAP
This  device category offers support for older devices with Wireless Markup Language (WML)22. As of 
2012, WAP use has largely disappeared.
Template: mobile_wap

• iMode
iMode is NTT DoCoMo's  mobile standard23 that is still used by 51.6 million customers in Japan and 
over 5 million in the rest of  the world
Template: mobile_imode

LAYOUT SETTINGS
It's possible to configure the mobile site layout in a global way and depending on the device category.

Let's have a look at the Smartphone tab (Figure 6).

It is divided in 6 boxes

Settings

In the settings box you can choose the mobile template. Mobile Joomla offers additionals  templates to 
buy.

Homepage

It's  possible to choose a link from a menu to be the mobile homepage. It is possible to to disable the 
HTML output of  a component, which can be very useful.

Image
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The global image parameters can be overridden and there is an additonal possibility to add a margin 
of x pixel to the rescaled image and to add automatically the <img> style attribute height and width 
(width:...px !important; height:...px !important;).

Figure 6: Smartphone Settings

Advanced

In the advanced box you find a possibility

• to set the Gzip compression for reducing the size of  your page.

• to remove unsupported tags like iframe, object, embed and applet

• to remove all JavaScript code

• to convert HTML entities into symbols, so that UTF-8 symbols will be used instead of  &euro; etc.

• to set the content type header

Template Modules

All mobile templates have the same structure
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Header Modules Area

Breadcrumbs

Middle Modules Area

Component area

Footer Modules Area

Joomla! Footer

Support ads

Depending on the templates,  there are various positions available. You can select the desired module 
positions.

Template Options

This box is only in the general smartphone tab available and it offers the possibility

• to choose between the standard or a simplified <header> block. The simplified block contains  the 
page title only and CSS/JS that is loaded by template only

• to load extended editors (TinyMCE, etc.)

• to embed a css/custom.css into the page,  because usually it’s quite small and it’s  faster to load with 
the page instead of  waiting for a separate request.

• to start with a <?xml version="1.0" encod-ing="utf-8" ?> header.

• to specifiy which DOCTYPE to use for your pages

• to specify if the xmlns attribute should be included in the HTML element,  so that it  will look like 
this:
<html xmlns="http://www.w3.org/1999/xhtml"> instead of  <html>.

COMPATIBILITY WITH 3RD PARTY EXTENSIONS, MODULES AND 
COMPONENTS

Mobile Joomla offers several extensions 24 for 3rd party extensions. Some of  them are freely available.
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Chapter 6

Apps and Ecosystems
I often hear these two statements  when people talking about web applications, HTML5 and the 

future of  mobile devices in general:

1. Each smartphone has a web browser and it is permanently connected to the internet.

2. With HTML5, native apps are not necessary anymore and will disappear.

In theory, both statements are correct. But the reality is more complicate.

1. Even if the smartphone has a web browser and even if it's permanently connected to the 
internet,  most telephone companies  charge their clients  based on data traffic. In your own country 
that might be affordable,  but it can be very expensive in case of roaming to another telco in another 
country.
The speed of the networks is not always available to download large amounts  of data because of a 
lack of  coverage in nearly every country.

2. HTML5 is still "experimental". It will be a full recommendation in 2014 (planned). Today there 
is a lack of accessible API's when you e.g. try to access  the inbuilt mobile device camera via a web 
application.

And last but not least. Existing app stores are a possibility for app developers  to earn money with 
their native apps!

NATIVE APPS AND WEB APPLICATIONS
An application (app)  is computer software as  you know it from your PC. Microsoft Word and Adobe 

Photoshop are just "apps". They are called "native" too because the human readable source code was 
compiled to machine readable byte code for various reasons. A web application is  an application that is 
accessible via a browser over the Internet or an intranet. The source of a web application is  usually not 
compiled.

• The native app has to be installed on the device and it runs "on its own".
The web application exists in a web browser. It is not necessary to install something.

• The native app is developed exactly for the device where it is installed.
The web application relies on the browser that interprets its code properly.

• The native app can be "packaged" easily and sold via an app store.
A web application is usually available for free or behind a paywall secured with a login.
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• Most native apps are working WITHOUT having internet access!

FACEBOOK APPS
Facebook launched the Facebook Platform25 in 2007, providing a framework for software developers 

to create applications  that interact with core Facebook features. A markup language called Facebook 
Markup Language was introduced simultaneously. It is  used to customize the "look and feel" of 
applications that developers create.
Facebook Apps are stand-alone websites,  which are displayed inside Facebook in an iFrame. Between 
Facebook and the Website exists  a relationship to the Facebook App ID/API key. The website can access 
Facebook data.
A Facebook app is  a kind of a web application that relies  on and is  tied to Facebook Inc. Even if 
Facebook is not looking like an App-Store, it is  probably one of the biggest app stores and the prototype 
of  an ecosystem.

ECOSYSTEMS
In biology, an ecosystem is  a community of living organisms (plants, animals and microbes)  in 

conjunction with the nonliving components  of their environment (things like air, water and mineral soil), 
interacting as a system.

In the app economy we have living organisms:

• the client/user

• the developer

• the shareholders/owners of  the various involved companies

and the environment:

• a central place for buying and updating the apps

• an easy possibility to pay

• a central login

• development tools that allow the creation of  apps

APP STORES
Apple started its app store in 2008. Depending on the application,  they are available either for free or 

at a cost. The applications can be downloaded directly to the target device. 30 percent of the revenue 
from the store goes to Apple, and 70 percent goes to the producer of  the app.
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This  started a kind of revolution and today, nearly all big tech companies are trying to provide an 
app store for it's products, e.g.:

Amazon Appstore26

Google Play27

Windows Store28

Ubuntu Software Center29

APP ECONOMY
Since the launch of the first iPhone in 2007,  the production and mainstream usage of smartphones 

has exploded. The device opened a world of innovation in mobile technology, which was soon followed 
by a similar boom from apps. App development has  created 466,000 jobs across all available platforms, 
according to a survey performed by TechNet30.

POST APP ECONOMY
HTML5 will be standardized and finally available in 2014, data traffic and roaming will get cheaper 

and the coverage of high speed network will grow. The integration of phone operating systems  API's will 
get better and the browser based web applications will take over the market.

But there has to be a possibility for the ecosystem as a whole to earn money and at the moment only 
the app economy, which is  based on the distribution of native apps and files  (mp3, mp4, ebooks)  offers 
this feature too!
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Chapter 7

Responsive Webdesign
Responsive Web design simply means  that the layout of your website is  changed based on the size of 

a device viewport.

The early beginnings of the world wide web in 1993 were responsive, even there were not so many 
different viewports on different devices available.

You don't believe it? Have a look at Figure 1 and try the <h1> <p> and <table> tag by yourself.

Figure 1: Website 1993

This is the HTML code

<h1>Headline</h1>

<p>Lorem ips... Aliquam ante nullam.</p>

<table border="1">

  <tr>

    <th>Aliquam ante nullam .... Aliquam ante nullam.</th>

    <th>Aliquam ante nullam .... Aliquam ante nullam.</th>

  </tr>
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  <tr>

    <td>Aliquam ante nullam ... Aliquam ante nullam.</td>

    <td>Aliquam ante nullam ... Aliquam ante nullam.</td>

  </tr>

</table>

Listing 1: Website 1993 HTML

The problem in this time was,  that all information about the layout, colors  and font were included in 
one big HTML file.

In 1996,  the first release of Cascading Style Sheets (CSS)  appeared! It was designed to enable the 
separation of document content from document presentation,  including elements  such as  the layout, 
colors, and fonts. It was  possible to create a seperate file with CSS statements and you could apply the 
styles for every HTML document by including this file.

<link rel="stylesheet" href="http://example.com/style.css" type="text/css" />

A simple CSS file looked like this

h1{  color:red;}

p{  font-size:12pt;}

table{  border: 1px none;}

Listing 2: Website 1996 CSS file

The output was  the nearly same compared to figure 1 (Just the headline is now colored red) and it 
was still "responsive" as long as the designers didn't use the Absolute CSS Positioning.

Absolute CSS positioning tells  the browser that whatever is going to be positioned should be removed 
from the "normal flow" of  the document and will be placed in an exact location on the page.

One one hand this was  a dream for people that came from print because they could build a website 
exactly like the printed brochure,  and on the other hand it was a nightmare for the "normal flow" of a 
website.

DISPLAY STANDARDS
Computer displays standards  are described as  a combination of aspect ratio (specified as  width-to-

height ratio),  display resolution (specified as  the width and height in pixels). Several display used to have 
an aspect ratio of 4:3 in the past. In recent years  the 16:9 aspect ratios  become more and more popular. 
To get an impression of the amount of common resolutions,  have a look at the wikipedia List of 
common resolutions31. Concerning mobile devices, let's have a look at a few examples:
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• Apple 
iPad 1024 x 768 - Ratio 4:3
iPad3 2048 x 1536 - Ratio 4:3
iPhone 320 x 480 - Ratio 3:4
iPhone 4 640 x 960 - Ratio 2:3
iPhone 4S 640 x 960 - Ratio 2:3
iPod Touch 320 x 480 - Ratio 2:3

• HTC
3100 240 x 320 - Ratio 2:3
8282 480 x 800 - Ratio 3:5
Athena 640 x 480 - Ratio 4:3
Mozart 480 x 800 - Ratio 3:5
Oxygen 176 x 220 - Ratio 4:5
...

I stop here and I guess  you can imagine the "absolute position" will lead to problems. Not only 
because the different aspect ratios and display resolutions. If you look for example at the iPad3, the 
display resolution of  2048 x 1536 pixel is higher than on most personal computer screens.

This lead us to the question of  "how to display" images in a "responsive" way.

IMAGES 
If you just want to display text, everything is easy. But when it comes to images, things can become 

complicate. Joomla for example has no inbuild image resizing feature in core. There are several 
extensions to solve that problem, but it's necessary to install something additional.

Imagine you want to write an article and include an image in that article. The width of the image is 
800px and your website visitors are using iPhones (640x960px)  and the last iPads  (2048 x 1536px)! On 
one device the image is too small, on the other device it is too big!

The best solution would be to have flexible images  or a resizing mechanism that fits in each device 
perfectly!

The Mobile Joomla extension for example resizes the images physically, depending on the device.

The Twitter Bootstrap Framework e.g. uses responsive image handling (see chapter Using the Twitter 
Bootstrap Framework to build a responsive Joomla! Template from Scratch)

ASK THE DEVICE! (MEDIA QUERIES)
The W3C created media queries  as part of the CSS3 specification. A media query offers the 

possibility to inspect the physical characteristics  of the device rendering the page. The solution to the 
problem above is simple: "Ask the device!"
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<link rel="stylesheet" type="text/css"

  media="screen and (max-device-width: 480px)"

  href="fitou.css" />

The query contains  a media type (screen),  and the actual query (max-device-width) to inspect, followed 
by the target value (480px). We’re asking the device if its  horizontal resolution (max-device-width) is  equal 
to or less than 480px. If  the test passes, then the device will load fitou.css.

You can combine multiple media queries. The following code will apply if the viewing area is 
between 600px and 900px.

@media screen and (min-width: 600px) and (max-width: 900px) {

  .class {

    background: #333;

  }

}

TEST YOUR WEBSITE
Have a look at different websites and how they are dealing with different device sizes.
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Figure 2: joomla.org has a responsive template

http://mattkersley.com/responsive/ (Figure 2).

http://quirktools.com/screenfly/
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Advertisement

We are a small extension development company based in 
Germany. We love Joomla and we love more than anything to build 
simple and yet powerful Joomla extensions.

Thousands of users have already used our components such as 
CComment, Hotspots, CMigrator, Matukio. If you haven't heard 
about those, than what are you waiting? Visit our website and find out 
more now!

http://compojoom.com
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Chapter 8

What exists in Joomla! Core so 

far?
The bad news  is: If you look at the Joomla! 2.5 core package, there is  no mobile and no responsive 

template included.

The good news is: You can easily install solutions based on third party extensions.

When you start looking for responsive templates, you'll soon find out,  that most of the available 
templates  are based on template frameworks. Often these frameworks were developed by template clubs 
or website agencies to reduce the amount of  work for a new template.

A few examples:

• JAT3 Framework - Elastica 32 - Free

• Construct Template Development Framework33 - Free

• Foundation34 - Commercial

Available responsive templates without a dedicated framework are for example

• Blank Template35 - Free

• OneWeb Template36 - Free

All these templates can be good starter themes  for your own project. You can install and modify them 
for your own purpose.
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TWITTER BOOTSTRAP FRAMEWORK IN JOOMLA 3.X CORE
Frameworks in general have advantages  and make life easier. But one of the biggest problems is to 

choose the best framework for your requirements. There is  one project called Twitter Bootstrap. It is 
developed and used by Twitter. Twitter Bootstrap is a simple and flexible HTML5, CSS3, and Javascript 
Framework for popular user interface components and interactions and

Figure 1: Joomla 3.x Frontend and Backend

• Joomla can get so much for free

• it’s modern and minimal

• practically every UI element is already there

• it’s continuously tested and improved

• the barrier for entry into Joomla is lowered

• it includes support for all major browsers (even IE7!) and tablets and smartphones, too.

• it has a 12 column grid system
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• it's  fully responsive. The components  are scaled according to a range of resolutions and devices to 
provide a consistent experience

• it's created by Twitter37

• "it's simply the best out there - period"38.

For these reasons and after long discussions, the Joomla production leadership team decided to 
include Twitters Bootstrap Framework in the core package of  the new Joomla 3.x series (Figure 1).

The long  term release Joomla 3.5 will be the sucessor of the long term release Joomla 
2.5 in September 2013.

JOOMLA 2.5 AND BOOTSTRAP?
Even in Joomla 2.5 you can use Twitter Bootstrap. The future core default template for Joomla 3.x 

series is called Strapped (Figure 2) and it is available for Joomla 2.5 too39 

Figure 2: Strapped Template

The template itself  is for free but you have to register at the site.
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There are also two commercial Twitter Bootstrap based Joomla 2.5 templates available

• JBootstrap40 

• joostrap41

WHERE AND HOW TO START?
In general,  it is  a good idea to have a look under the hood of Joomla 2.5 and learn about template 

styles42 and template overrides 43. With the decision of using Twitter Bootstrap in Joomla 3.x core you 
should start getting familiar with it.
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Advertisement

"We are building a template club with a twist... We thought, what if 
you could have a Joomla! template, and with a few easy clicks, 
completely change it visually in a hundred different ways, regardless 
of  the content?

"So we put on our creative thinking hats, got to know the T3 
framework, CSS 3, HTML 5, made lots of great artwork, put it all 
together for Joomla! 1.7, and hey presto, we have Tc4j, a completely 
new way of  using templates!

"...and we made it for you ... and we think you'll love it!"

See you soon, David & Andreas

http://www.tc4j.com

Going Mobile with Joomla!

Thursday, 9 August 2012 Page 50

http://www.tc4j.com
http://www.tc4j.com


Chapter 9

Using the Twitter Bootstrap 

Framework to build a responsive 

Joomla! Template from Scratch
In this  chapter we want to look under the hood of the Joomla template system to understand the 

basics. Creating a template from scratch is  no rocket science. When you are building a website you 
always  need to decide whether it is  better to create a template on your own or to buy one. Besides of 
these two options  you can also modify an existing template. To be able to make a useful decision you 
need to understand the process of  creating a Joomla template.

TEMPLATES IN JOOMLA
Joomla consists  of a frontend (the website)  and a backend (the administration interface). Both parts 

have their own templates. They are stored in the folders

• /templates - Frontend

• /administrator/templates - Backend

Each template has it's  own folder. In Joomla 2.5 you'll find two preinstalled non responsive templates 
(Beez 2 and 5) and one template framework (Atomic)

• /templates/atomic
Atomic a kind of  an uncommon template framework 44

• /templates/beez_20
Beez 2 is the Joomla standard template 45.

• /templates/beez5
Beez 5 is the HTML5 version of  Beez 2
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• /templates/system
In this folder Joomla stores all the files that are common for all the templates, e.g. the Offline and the 
Error page.

The administrator folder looks the same

• /administrator/templates/bluestork
Bluestork is the default standard administrator template

• /administrator/templates/hathor
Hathor is an optional administrator template. It is accessible and colours are customizable.

• /administrator/templates/system
In this folder Joomla stores all the files that are common for all the templates, e.g. the Error page.

HOW TO CREATE A NEW TEMPLATE?
You have three options for creating a new template

1. start from scratch with creating a folder and all the necessary files

2. install a starter theme and modify it

3. copy an existing template and modify it

In this chapter we want to try option one. We'll create a responsive frontend template based on the 
Twitter Bootstrap framework for Joomla 2.5 from scratch. I'll keep it as simple as  possibible. The aim of 
this  chapter is  to understand Joomla's template structure. It's quite easy to make it more and more pretty 
and complicate afterwards :)

TEMPLATE NAME
First of all we need a name for our template. The name will appear in XML files, the database, the 

webservers files system and several caches. Avoid special characters and blanks in the name. I'll call the 
template cocoate.

FILES AND FOLDERS
Create a /templates/cocoate folder.

In the folder we need the following files and a subfolder css

• /templates/cocoate/index.php

• /templates/cocoate/templateDetails.xml

INDEX.PHP
<?php

defined('_JEXEC') or die;
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?>

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://
www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">

<html xmlns="http://www.w3.org/1999/xhtml" xml:lang="<?php echo $this-
>language; ?>" lang="<?php echo $this->language; ?>" >

<head>

<jdoc:include type="head" />

</head>

<body >

<jdoc:include type="modules" name="top" style="xhtml" />    

<jdoc:include type="modules" name="breadcrumbs" style="xhtml" />

<jdoc:include type="modules" name="left" style="xhtml" />

<jdoc:include type="component" />

<jdoc:include type="modules" name="right" style="xhtml" />

<jdoc:include type="modules" name="footer" style="none" />    

</body>

</html>

Listing 1: index.php

The index.php  file is  the "page" template,  the "big picture". Inside this file all the bits  and pieces  (CSS, 
JavaScript,  Joomla content) were loaded. In our example I just loaded the Joomla content with the 
<jdoc:include ...> command. It contains the head, the component content and the module content 
depending on the postion of  the module (What is a module?46).

templateDetails.xml

This  is the most important file in a template. It is the manifest, or packing list  file that includes a list 
of all the files or folders  that are part of the template. It also includes information such as the author and 
copyright. Without this file, Joomla wil not find your template. The positions  are the module positions 
that are already mentioned in the index.php file. You can create as many positions  as you want. So far, 
there is no naming standard in Joomla.

<?xml version="1.0" encoding="utf-8"?>

<!DOCTYPE install PUBLIC "-//Joomla! 1.6//DTD template 1.0//EN" "http://
www.joomla.org/xml/dtd/1.6/template-install.dtd">

<install version="2.5" type="template" method="upgrade">
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    <name>cocoate</name>

        <creationDate>2012-07-17</creationDate>

    <author>Hagen Graf</author>

    <authorEmail>hagen@cocoate.com</authorEmail>

    <authorUrl>http://cocoate.com</authorUrl>

    <copyright>Copyright (C) 2012 cocoate</copyright>

    <version>1.0</version>

    <description><![CDATA[

    <p>cocoate is a template exercise from scratch.<p>

    ]]></description>

    <files>

        <filename>index.php</filename>

        <filename>templateDetails.xml</filename>

        <folder>css</folder>

    </files>

    <positions>

        <position>top</position>

        <position>breadcrumbs</position>

        <position>footer</position>

        <position>left</position>

        <position>right</position>

        <position>footer</position>

    </positions>

</install>

Listing 2: templateDetails.xml

DISCOVER AND INSTALL YOUR TEMPLATE
After creating the two files  and the folders, we have to discover and install the template. Since Joomla 

1.6, a template is "registered" in the _extensions database table. Go to Extensions -> Extensions manager -> 
Discover. Click the Discover Icon on top. You will see your freshly created template (Figure 1). Check the 
template and click on install (Figure 2).
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Figure 1: Discover the cocoate template

Figure 2: Install the cocoate template

During the install process, there has been automatically created also a template style. Check this  style 
(Extensions -> Template Manager) and make it the default template style (Figure 3).

Figure 3: Choose the cocoate template as default template

Visit your website and have a first look at your template (Figure 4).
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Figure 4: Your website with your new template

When you play around and open the site also with your mobile device,  you'll notice that it is  fully 
responsive :) But there is no real "User Interface", this is not so pretty and we have no images so far.

INTEGRATE TWITTER BOOTSTRAP FILES
Now it is necessary to integrate Twitter Bootstrap before we continue. At the time I wrote this text, 

the version 2.0.4 was the latest release.
In this  example I use the Twitter Bootstrap package that comes  with a documentation47  (Figure 5). 
Download and unzip the package48 and copy the folder /assets into the /template/cocoate folder (Figure 6).

The assets folder contains  the necessary CSS and JavaScript files  and it comes  with predefined 
images and icons. 

Later on,  when you are more experienced with Joomla templates, you can put the necessary Twitter 
Bootstrap files into a different folder. For our example it is easier to use the /assets folder.

Going Mobile with Joomla!

Thursday, 9 August 2012 Page 56

47 http://twitter.github.com/bootstrap/

48 https://github.com/twitter/bootstrap/zipball/master

http://twitter.github.com/bootstrap/
http://twitter.github.com/bootstrap/
https://github.com/twitter/bootstrap/zipball/master
https://github.com/twitter/bootstrap/zipball/master


Figure 5: Twitter Bootstrap website

Figure 6: copy or move assets folder
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INTEGRATE TWITTER BOOTSTRAP INTO YOUR TEMPLATE
Twitter Bootstrap comes  with three example templates called hero,  fluid and and starter-template. 

You can check them by clicking on the files in the /example folder.
Our aim is  to combine the Joomla related commands with one of these examples. For the example I 
chose the fluid template (fluid.html).

The /templates/cocoate/index.php contains all the necessary Joomla parts. We need to create a mixture 
of  both parts, let's start with a few key elements we need in the file:

<?php

defined('_JEXEC') or die;

// detecting site title

$app = JFactory::getApplication();

?>

This  is php code and the typical start of a Joomla template. The object $app  contains useful data 
about your Joomla, e.g. the name of  your website.

<!DOCTYPE html>

<html lang="en">

This doctype is the HTML5 version and comes from the Twitter Bootstrap example.

In the <head> section we have to create the Joomla Metatags  via a <jdoc> command and integrate 
the Bootstrap files. 

<head>

  <meta charset="utf-8">

  <jdoc:include type="head" />

  <meta name="viewport" content="width=device-width, initial-scale=1, maximum-
scale=1">

  <link rel="stylesheet" href="<?php echo $this->baseurl ?>/templates/<?php echo 
$this->template; ?>/assets/css/bootstrap.css" type="text/css" media="screen" />

  ...

  <!-- ... more Bootstrap files ... -->

  ...

  <link rel="apple-touch-icon-precomposed" href="<?php echo $this->baseurl ?>/
templates/<?php echo $this->template; ?>/assets/ico/apple-touch-icon-57-
precomposed.png">

</head>
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The <body> section can be mostly copied from the fluid.html example. It's  important to embed the 
<jdoc> commands at the right place.
This  is  an example for the top menu. You have to place a menu module at the position top-menu and 
you can e.g. show the sitename from the $app object

<div class="navbar navbar-fixed-top">

  <div class="navbar-inner">

    <div class="container-fluid">

    ...

    <a class="brand" href="#"><?php echo $app->getCfg('sitename'); ?></a>

    <div class="nav-collapse">

      <jdoc:include type="modules" name="top-menu" style="none" />

    </div>

  </div>

</div>

The main page is  located in a so called "Fluid Container". It has  a grid system with 12 rows by 
default. We use 9 of them for the display of the Joomla component and 3 of them for a sidebar on the 
right side, called right. The right side should only be shown if  there are modules available.

<div class="container-fluid">

  <div class="row-fluid">

    <div class="span9">

      <div class="hero-unit">

        <jdoc:include type="component" />

      </div>

    </div><!--/row-->

  </div><!--/span-->

  <div class="span3">

    <?php if($this->countModules('right')) : ?>

    <div class="well sidebar-nav">

      <jdoc:include type="modules" name="right" style="none" />

    </div><!--/.well -->

    <?php endif; ?>

   </div><!--/span-->

 </div><!--/row-->
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</div><!--/.fluid-container-->

The last pieces are the Twitter Bootstrap JavaScript files at the end:

<script src="<?php echo $this->baseurl ?>/templates/<?php echo $this-
>template; ?>/assets/js/jquery.js"></script>

<script src="<?php echo $this->baseurl ?>/templates/<?php echo $this-
>template; ?>/assets/js/bootstrap.min.js"></script>

<script type="text/javascript">

        jQuery.noConflict();

</script>

As you see,  the JavaScipt framework jQuery is  loaded and also the minimal version of Twitter 
Bootstrap. You can see the content of  the complete index.php file here49.

The result is  far from perfect (Figure 7)  but it looks like a website and it's  ... responsive. Try it with 
your browser window and your smartphone!

Figure 7: First look at the new template

JOOMLA OVERRIDES
So far,  everything was easy. Now the real work is starting. You have to override the default Joomla 

HTML output to get the full advantage of the Twitter Bootstrap Framework (Figure 8). It's quite hard to 
learn all the details about the HTML output of of modules in genaral. For this  chapter, I suggest use 
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existing overrides. Thanks  to the work of   Gary Gisclair50  it is  possible to download the Strapped 
template51 and use the existing overrides. I just copied the whole /html folder into the /templates/cocoate 
folder.

If you don't know what I mean with Overrides,  have a look here52  (for developers)  and here53  (for 
users).

Figure 8: HTML Overrides

THE DROPDOWN MENU
Joomla has no default menu with a dropdown option but Twitter Bootstrap offers dropdown support 

for menus and of  course, we want to have exactly this feature in our template. 
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I use the default Joomla example data and put the Main Menu Module to position top-menu. To 
match the correct CSS class  I need to add " nav-dropdown" (Attention, there must be a blank at the beginning) 
in the Menu Class Suffix (Extensions -> Module Manager -> Main Menu -> Edit -> Advanced Options) (Figure 9)

Figure 9: Main Menu - Advanced Options

IT WORKS!
The communication between Joomla and the Twitter Bootstrap is working. The Dropdown Menu is 

fully responsive and even the pictures will be automatically resized (Figure 10).

Figure 10: Responsive Template based on Twitter Bootstrap

I installed this example template on my testsite too, so have a look at http://joomla25.cocoate.com.
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NEXT STEPS
From my point of  view, the next steps are

• just playing around with other technologies (CSS, JS, HTML5, Joomla, PHP, Twitter Bootstrap)

• have a look at the Twitter Bootstrap documentation54

• create Custom CSS

• use Joomla Parameters to configure the template

CONCLUSION
I hope,  you are now able to decide whether you want to go deeper into Joomla templating with the 

Twitter Bootstrap framework or just choose with a ready made template.
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Advertisement

Whatever your style.

Jade Black Design offers web design services on a personalized 
level. Our designers and web developers work together to provide you 
with a creative, tailor-made approach to web design. Whatever your 
style, Jade Black can design a website that suits you. We design logos 
and printed materials as well, and provide translations, illustrations, 
and photography. You've got style. You've got a growing business. And 
you need a great website. Contact Jade Black Design and lets get 
started on your site.

http://www.jadeblackdesign.com
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Chapter 10

Chimoora for Android
Written by Achim Fischer, Chimoora developer

Chimoora is a Joomla! client app which brings  the features  of a Joomla! powered website to mobile 
devices. Different operating systems will be supported. The first one will be Android 4 (Ice Cream 
Sandwich). BlackBerry 10, Windows  8 and iOS are on the radar as well. Chimoora 1.0 will support 
Blogs (Joomla! featured articles)  and Forums (powered by Discussions). The next version will bring 
Private Messages  (Discussions)  and Classified Ads (Marketplace). On the serverside, Chimoora needs a 
Joomla! API extension which is  developed as part of the Chimoora project in parallel. The API 
extension is a "normal" Joomla! component and is simply installed via the extension manager.

REQUIREMENTS
• Chimoora is an Android 4 (Ice Cream Sandwich)  native app and therefore it requires Android 4.x 

on the mobile device

• The Joomla! API extension needs Joomla! 2.5 or above to work.

THE CHIMOORA APP
Chimoora is currently in an early beta stage. Here is  a short roadmap, so you can see what you can 

expect in the upcoming versions.

For Version 1.0 the following features are planned:

Home Feed
• Home Feed List

• Feeditem Detail View

Blogs
• Category Listing

• Article List

• Article Detail View

Forums
• Forum List

• Thread List
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• Post List

• Reply to Post

• Compose new Thread

For Version 1.1 the following features are planned:

Private Messages
• Inbox List

• Message Detail View

• Reply to Message

• Outbox List

• Message Detail View

• Compose new Message

Classifieds
• Category Listing

• Entry List

• Entry Detail View

• Compose new Entry

CHIMOORA SCREENSHOTS
Figure 1: Left: Homescreen showing a feed containing Joomla! featured articles,  forum posts  and 

classified ads.
Right: List of Joomla! categories with a default icon. If an icon is  set for the category,  it will show up 
here.

Figure 2: Left: List of available forums. The forum icons are set in the backend configuration for the 
Discussions forum extension.
Right: List of  threads in a selected forum.

Figure 3: Left: List of  blog posts in a selected category.
Right: Detail view of  a selected blog post.

Going Mobile with Joomla!

Thursday, 9 August 2012 Page 66



Figure 1: Homescreen

Figure 2: Forums
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Figure 3: Blog posts

THE JOOMLA! API EXTENSION
There must be "something" on the server to which the app can send requests  and from which it 

receives responses. This is called an API and Chimoora uses a REST API.
The API is realized through a Joomla! extension. It's a normal component which can be installed in the 
Joomla! backend. The first version of the API is pretty simple. Chimoora and the API version 1.0 will 
support Joomla! articles  and forum posts. Private messages  (powered by Discussions)  and classified ads 
(powered by Marketplace) will be added later.

INSTALLATION
The installation of the Chimoora API extension is  very simple. Just go to the Joomla! backend and 

install it like any other extension:

Joomla! Backend -> Extensions -> Extension Manager -> Install

In the first box "Upload Package File" select the downloaded Chimoora API zip file and click "Upload & 
Install".
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If you click on the new entry in your "Components" menu you should see the Dashboard of the 
Chimoora API.

CONFIGURATION
There is at least one step needed before you can use the API from a mobile app.

Create a menu entry which points to the Chimoora API extension. Currently it must have the alias 
"api". Note: The menu entry does not have to be in the main menu and it does not have to be visible. 
Recommended is a menu entry in an invisible menu.

If you would like to allow other apps or services to access your API later, you would have to create 
API Keys for those. This is  not required for now. The Chimoora API extension comes with a predefined 
API Key for the Chimoora app.

Figure 4: Chimoora API Keys
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Figure 5: Chimoora API Keys - Details

CONCLUSION
The Chimoora project is  work in progress. First goal is  to launch a "branded" Chimoora for Android 

version which will have the Codingfish website hardwired as  an API endpoint. This Codingfish app will 
be uploaded to the Android Play Store as soon as possible to see how it behaves under real conditions.

The final Chimoora app will offer a configuration tab where anyone can add several websites. Please 
note again, that those websites will have to run the Chimoora API extension.

Versions for other mobile operating systems are planned.

Follow @codingfish and @chimoora on Twitter or visit www.codingfish.com for more information.

Preview on YouTube55 
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Chapter 11

Mobile Content Editing
If you and your users  want to create and edit content on your mobile website,  there are in general 

two possibilities.

• using the mobile web browser

• using a native app

As long as we only talk about adding and editing text, everything is possible. But it can be a problem 
to use a WYSIWYG editor because they are often simply don't work on a mobile device. If you want to 
upload an image from your mobile device it can be a challenge.

Figure 1: Joooid
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In this chapter I want to have a look at two apps that offer content editing for your Joomla website. 
Joooid56 is available for Android, JomMobile57 for Android and iOS.
Both apps consist of two parts: the app, which is downloadable from Google Play Store and Apple App 
Store and a Joomla extension which is  downloadable from the projects website. In the Joomla extension 
is a plugin that provides an API for accessing Joomla from the app. Both projects  offer possibilities to use 
their API for own projects and Joooid even offers the Android Library58 to make the development easier.

JOOOID
Joooid (with three "o")  is  a free app/extension for Android devices (Figure 1). It consists of an app and 

a Joomla extension. The developer is Stefano Norcia59.

Joooid allows you to

• create or edit articles, change title,  alias,  category, status,  access level,  frontpage and scheduled 
publishing.

• create content with the WYSIWYG with html markup and links, in full screen! 

• add images and galleries using pictures from your device.

• add youtube videos or share images and videos with Joooid directly from Image Gallery or Youtube 
App. 

• geotag articles, embed maps  with your current position using GPS/Network or set the map 
coordinates with the handy map picker. You can also share a location to Joooid directly from the 
Google Maps application.

When I first read the list of  features, I thought: "wow"

You have to install the app on your Android device and the extension in your Joomla! website. There 
are versions for Joomla 1.5 and for Joomla 1.6, 1.7, 2.5. 

After installing the Joomla extension, you need to activate the two joooid plugins. Then it's  possible 
to connect the app with the website by adding the URL,  your username and your password. Afterwards, 
you will see an impressing user interface. I managed to add an article with a photo,  an image gallery and 
a Google map from my old HTC wildfire. The biggest problem for me was typing the text :).
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There are several configuration panels  (e.g. image resizing)  and it's of course necessary to enable the 
location detection on your phone to use the Google maps feature.  (Figure 2, Figure 3, Figure 4).

Figure 2: Joooid - Article Editor - Text

Figure 3: Joooid - Content Elements
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Figure 4: Joooid - Article Editor

At the Joooid website you find a detailed tutorial about all the features60.

JOMMOBILE
The native iOS and Android app jomMobile offers a way to manage articles, categories, menus and 

users on several Joomla sites.

Figure 5: JomMobile
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You have to install the app and a Joomla component (Figure 6).

Figure 6: Install Message

JomMobile has a clear business model. The free app shows advertisements and it's not possible to use 
additonal plugins, e.g. the k2 support. It's also not possible to edit user accounts.

Via in-App purchase, you can buy the plugin feature, removal of advertisements  and the permission 
to edit user accounts. I tried the app on an iPad and it worked well for adding and editing articles, 
categories  and menu entries. Text appear with HTML tags, because It uses no WYSIWYG editor (Figure 
7).
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Figure 7: Article edit form
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Chapter 12

Conclusion and Comments
This book was written between May and July 2012 and compared to other CMS, I was  surprised 

what's already possible in Joomla.

More and more people will use mobile devices, the speed of internet connections will increase,  the 
prices will decrease. Today, the Joomla 2.5 core package is  not well equipped for the mobile world, but 
the world wide community offers interesting solutions and ideas.
From my point of  view it's very necessary to implement as soon as possible into Joomla! core:

• Mobile and responsive default templates with lots of  configuration parameters

• A well defined API so that there is a common base for third party developers. At the moment 
everyone is inventing the wheel on it's own again and again.

Not that important at the moment, but very nice to have would be an app like joooid,  that is  officially 
distributed by the Joomla project and available for various platforms.

A chapter of this  book has been published in the August Issue of the Joomla magazine61 and I got a 
few comments with some hints and information how others provide mobile solutions.

I would be very happy to receive more comments to this  book with your experiences,  tricks and ideas 
to make it easy to mobilize Joomla62.
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More books from cocoate

Joomla! 2.5 Beginner’s Guide

Joomla! Development for Beginner’s

http://cocoate.com/publications 
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cocoate.com is  the publisher of this  book and an independent management consultancy,  based in 
France and working internationally.

Specialized in three areas – Consulting,  Coaching and Teaching – cocoate.com develops  web based 
strategies for process  and project management and public relations;  provides  customized trainings  for 
open source content management systems Drupal,  Joomla and WordPress,  in the area of management 
and leadership skills and develops educational projects with the focus on non-formal learning.

The European educational projects  focus on the promotion of lifelong learning with the goal of 
social integration. Particular emphasis is  placed on learning methods in order to learn how to learn, the 
conception and realization of  cross-generational learning strategies and local community development.

http://cocoate.com 
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Spend your holidays in Southern France

We were captive to the charme of this  old French village from the beginning and that's  why we live 
and work in Fitou. We restored an old village house into holiday apartments  because we like to host 
guests and share with them our love for this region. 

Fitou is situated in the South of France, between Perpignan and Narbonne and is a typical French 
wine village having guarded the distinctive architectural village houses. The region around Fitou is 
known for its  wine and is as  diverse as it can be,  situated not too far from the Pyrenees  (one hour drive) 
and Spain. The Mediterranean climate allows  you to enjoy the freshness  of the Mediterranean sea at 
one of the beautiful beaches  enclosing the Étang from March until October,  as Languedoc-Roussillon is 
the sunniest area in France. The country of Cathar offers  not only old castles and abbeys but also the 
historical Canal du Midi.

Our apartments can be rented during the whole year. The apartments  are part of an old traditional 
stone house in the heart of Fitou. They have been carefully restored and modernized, respecting 
architectural aspects and conforming to the neighboring houses. Feel free to discover our apartments  and 
the region surrounding them!

http://fimidi.com 
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